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Marking Gauge 

This exercise will show you how to create the parts of a marking gauge, then fit them together into an 
assembly and finally create the working drawings. 
 

 
 

Exercise 1 – Building the Flange  

 
1. From the Application button, select New and then select “ISO Metric Part” to create a new 

part file.  

2. Click on the Line command in the Draw section of the Home tab. 

3. Hover the mouse over the X-Z plane and click the F3 key to lock the 

plane. This ensures that all drawing is done on the same plane, even 

when you select a different command.  

4. Click The Ctrl and the “H” key together to rotate the view to the sketch plane. 

5. Click the first point of the line at the centre of the coordinate system (below left). 

6. Move the mouse above the first point and you should see a vertical line icon on the cursor. This 

indicates that the line being displayed is vertical. The length box should be highlighted too (see 

below middle). The diameter is 70mm, but you are drawing half the profile, so type in the radius as 

70/2 and the value will change to 35. Click the point directly above the first point.  

7. The line command continues with the last point entered, being the first point of the next line. If you 

wish to re-start at a different point, right mouse click and the line command will start as new. Move 
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the cursor directly to the right and the Horizontal indicator should display. Enter 4 in the length box 

and click to place the line (see above right). 

8. Right mouse click to end the line string and start from a new location. 

9. Click the first point of the line at the centre of the coordinate system, as in step 5. 

10. Move horizontally to the right and type in a length value of 30 (below left) and click for the second 

point. 

Note:Note:Note:Note: If you intend to make a line vertical or horizontal and it moves off 

the axis when you click, you can straighten up the line by clicking 

Horizontal/Vertical command and then clicking the line anywhere apart 

from the end point or mid-point.  

Note:Note:Note:Note: Any line that has been drawn horizontal or vertical should have 

a + mark at the centre of the line. 

11. The next point will be placed vertically above the last at a distance of 12.5 (see below right). 

12. Place the next point to the left of the last point, but short of the Z axis (shown below left).  

13. Right mouse click to exit the line string. 

14. Place the first point of the next line at the right hand end of the short 4mm line place at step 7. The 

end point symbol should display (see below middle).  

15. The next point should be at an angle, so move the cursor down to touch the last line placed. Click 

the Tab key to switch to the angle box and key-in 75 and hit enter. Click to 

place the line on the last line placed (shown above right). 

16. In the Home tab, select the Trim command from the draw section.  

17. Click the left end of the line placed in step 12 and this will trim the line to 

the first intersection (ie. The angled line).  

18. This completes the profile that you will revolve to get the body of 

the flange. Click the F3 icon to the right of the screen to unlock the 

plane.  

19. Click the Ctrl and “I” key together to orient the view to an isometric view. 
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20. Notice that the area inside has turned light blue which indicates the profile is closed and can be used to make 

a solid. Click inside the area and you will see a blue dot appear where you click with 

an arrow extending in both directions. This is called the steering wheel and is used 

to generate solids. In it’s current state, you could click on an arrow and entend the 

profile to give it thickness. To create our flange, you need to rotate it about the 

bottom line, so grab the blue dot and drag it over the bottom line. When 

you let go of the mouse button, the steering wheel changes to display 

the torus (ring) that you can use to rotate the profile about the selected 

line.  

21. Click the torus and move the cursor to see the profile rotate 

around the selected line. In the Comand bar (this floating toolbar shows 

options for the active command), click the drop-down shown and select 

360, which will rotate the profile all the way around to create the shown 

solid. 

 

22. You will now create 2 holes in the flange. Click 

the Hole command from the Solids section of the Home tab.  

23. On the Command bar, click the options button  

24. Change the hole type to 

counterbore and the Hole 

Extents to Through All (left 

icon). Set the Counterbore 

diameter to 25, the 

counterbore depth to 5mm 

and the hole diameter to 

12mm. 

This hole is custom, so we 

are entering specific values 

(which is why the values stay 

highlighted in yellow). If you 

want a specific size, select it 

from the drop-down at the 

top and the correct sizes will be displayed. Click OK to use the entered values. 
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25. Click the mouse wheel and hold down to the left of the part and drag to the right to rotate the part 

so that you can see the large circular face of the flange. Alternatively, click twice on the viewing cube 

(bottom right of the screen).  

26. Hover the mouse over the face and move the cursor to the centre of the 

coordinate system triad (as shown) and click to place the hole. 

27. Once placed a 12mm piece of text will display with a leader line to the 

hole. If you want to change the hole settings, click the 12mm text and a 

dialog box will display for you to change sizes or you can click on the 

Command bar option button to change the hole type. 

28. Click Ctrl+I to return to the isometric view. 

29. Click on the Hole command and click the setting button on 

the command bar. Change the hole type to threaded and 

select M8 x 1 from the Size drop down box. In the Hole 

Extents, change the option to Through Next  and click OK. 

30. Move the mouse so that the hole is displayed on the smaller shaft diameter and click the F3 key to 

lock to the circumference of the shaft (below left). 

31. An angular readout will display to allow you to position your hole around the outside of the shaft. 

Click at the top point where it displays 90°. This locks the orientation of the hole. 

32. This hole needs to be in line with the centre of the plane (indicated by a dashed line). Place the hole 

roughly about three quarters from the large face (ie closer to the end of the part). Right mouse click 

to exit the hole comand. 

33. To fully position the hole, you will use the smart dimension command, located on the 

home tab.  

NoteNoteNoteNote: The smart dimension tool can be used to dimension individual elements or the 

distance between elements. 

34. Click the top edge of the hole just placed (see below left).  

35. For the second point of the dimension, click the centre of the coordinate system triad (see below 

middle).  
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36. If you drag left, the dimension will show the distance from the top of the hole to the centre. In this 

case, drag the cursor upwards and you will see the dimension change to the distance from the back 

face to the hole. Click above the part to place the dimension (see above right). 

37. A dialog box will then display to allow you to adjust the 

dimension value and/or lock the value so that it can only change 

if you force it do so. Make sure the arrow is pointing toward the 

hole and type in a value of 20 and hit the Enter key. The hole 

should move to the new location. 

38. From the Application button, click Info and then File Properties. In the Summary tab, enter Flange 

into the Title field. In the Project tab, enter 1001 in the Document Number field, 1 in the Revision 

Number field and Marking Gauge into the Project field. Click the OK button. 

39. From the quick access toolbar, click the Save button and call the file “Flange.par” and close the 

part. 

This completes the first exercise and part.This completes the first exercise and part.This completes the first exercise and part.This completes the first exercise and part.    

 

Exercise 2 – Building the Shaft  

1. From the Application button, select New and then select “ISO Metric Part” to create a new part file.  

2. Click on the Circle by Centre command  and place the first point (centre) at the centre of the 

coordinate system triad (see below left). 

3. In the Diameter text box type 12 and hit the Enter key (see below right). This will complete the circle 

and have the next circle ready to place. Right mouse click to exit the command. 

4. Click on the shaded area inside the circle and the steering wheel will display (see 

right). Click one of the arrows to extend the surface. If it is extending in only one 

direction, press the Shift key and it will be extended in both directions or click on 

the extrude symmetric button on the command bar. 

5. Type 180 in the length box and hit Enter (see right). Double click the mouse 

wheel to fit the view. 
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6. Press the Ctrl and “F” keys together to switch to the front view. Notice the circle of the shaft is 

displayed more like a polygon than a circle. This is done for faster display and can be adjusted by 

selecting the Sharpen option on the view tab (see below). 

7. Click on the Line command  and draw a horizontal line from 

one edge of the circle to the other, as shown. Switch back to 

the Isometric view (using Ctrl+I) and, using the Smart Dimension command, Dimension the length of 

the line to 6mm. (see below left). Select the region created at the top of the shaft and then select the 

arrow of the steering wheel. On the Command bar, change the extent option to Through All and 

click to remove the cut along the shaft (shown below right).  

8. Click on the hole command and click the options from the command bar.  

9. Change the hole type to Threaded and set the size to M5 and change the Thread extent to “To hole 

extent”. In the hole extents, click the Finite extent  and set the depth to 20mm. Click the V 

Bottom angle check box and leave the remainder of the settings as the defaults. Click OK to accept 

the values entered. 

10. Move to the edge at the left end of the shaft and the hole should snap to the 

centre of the circle (shown). Click to accept. 

11. Click on the Hole Command and then click the options on the command bar 

again and set the type to Simple, the sub type to drill size and the size to 3mm. 

Change the hole extent to through all and click OK to accept the changes. 

12. Press the Ctrl and “T” key to switch to the top view. Click F3 while the cursor is over the top flat 

face. Move the cursor over the mid-point (do not click) to get the alignment (see below left). Position 

the hole so it is aligned with the mid-point as shown and place the hole as shown (below right).  
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13. Click the Smart Dimension tool and click the edge (see below left), then click the edge of the hole 

just placed (see below middle). Adjust the view so that the dimension looks as below and click to 

place the dimension. With the arrow pointing towards the hole, change the value to 12 and hit Enter.   

 

14. Click on the Chamfer with Equal setbacks command. On the command bar, 

set the selection option to Edge/Corner and click the edge at each end of the 

shaft, setting the value to 1mm. Right mouse click to Finish. 

15. From the Application button, click Info and then File Properties. In the Summary tab, enter Shaft into 

the Title field. In the Project tab, enter 1002 in the Document Number field, 1 in the Revision Number 

field and Marking Gauge into the Project field. Click the OK button.  

16. From the quick access toolbar, click the Save button and call the file “Shaft.par” and close the part. 

 

This completes thiThis completes thiThis completes thiThis completes this exercise and part.s exercise and part.s exercise and part.s exercise and part.    

    

Exercise 3 – Building the Lockscrew  

1. From the Application button, select New and then select “ISO Metric Part” to create a new part file.  

2. Click the line command  and hover over the coordinate 

system. If the plane (Y-Z) does not highlight, hold the cursor 

still and the mouse icon will display. At this stage, right 

mouse click and you will see all of the faces/planes located 

under where the cursor is. Pick the Y-Z plane and then press 

the F3 key. Press Ctrl+H to switch to the skecth view.    

3. Place the first point of the line at the centre of the coordinate system. Move the cursor to the left and 

enter a length value of 26 (see below left). Click to place the line as horizontal.  

4. Place the next point above the last a key-in a distance of 4mm. Place the line as vertical (see above 

right). 

5. The next point will be placed to the right of the last to create a horizontal line of length 16mm.  
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6. The next point will be placed above the last to create a vertical line of 1mm. Right mouse click to 

finish the line. 

7. Click on the Arc by 3 Points command. 

8. Place the first point on the end of the last line placed and the second point at the centre of the 

coordinate system. Click the last point so that the arc is roughly perpendicular to the first line placed 

(see below right). 

9. In the Relate section of the Home tab, click on the Perpendicular command . Click the first line 

placed in step 3 and then click the arc. You will see an icon appear in the 

corner of the two elements selected to show that they will remain 

perpendicular to each other. If you ever want to remove this constraint, you 

just need to select it and hit the Delete key. Click the F3 icon to unlock the plane. 

10. Press Ctrl+I to rotate to the isometric view. 

11. Click the area inside the sketch and grab the blue dot of the steering wheel and drag it to the 

bottom edge (see below left). Click on the torus on the steering wheel and then change the extent 

setting on the command bar to 360.  

12. Click on the thread command. Click on the smaller shaft diameter (see below 

left). On the command bar, change the thread size to M8 and the extent to “To cylinder extent”.  
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13.  Click the Chamfer Unequal Setbacks command. Click the end of the threaded shaft (see below left) 

and then right mouse click to accept the face selected. Click the edge of the face just selected and 

then enter 4mm as the setback and 30 as the Angle. Right mouse click to accept the inputs and 

complete the command.  Click Finish.  

14. Click the Hole command and in the hole options, set the diameter to 3mm and the extent to 

Through all. Move the cursor over the head diameter and press the F3 key. Set the Angle arrow to 

point upwards. Place the hole in line with the mid-point of the plane and roughly as shown (below 

right).  

 
15. Select the Smart dimension command. Select the outside edge (shown below left) and then select 

the edge of the hole (see below middle). Place the dimension as shown, ensure the highlighted 

arrow is pointing toward the hole and change the value to 4mm. 

16. From the Application button, click Info and then File Properties. In the Summary tab, enter 

lockscrew into the Title field. In the Project tab, enter 1003 in the Document Number field, 1 in the 

Revision Number field and Marking Gauge into the Project field. Click the OK button.  

17. From the quick access toolbar, click the Save button and call the file “Lockscrew.par” and close the 

part. 

 

This completes thiThis completes thiThis completes thiThis completes this exercise and part.s exercise and part.s exercise and part.s exercise and part.    
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Exercise 4 – Building the Pin  

1. From the Application button, select New and then select “ISO Metric Part” to create a new part file.  

2. Select the “Circle by Centre” command  and place the centre of the 

circle at the centre of the coordinate system (see right). Set the 

diameter to 3mm and hit Enter. Double click the mouse wheel to view 

to full size.  

3. Click the area inside the circle and click on the arrow on the steering 

wheel. Ensure the extended profile is moving in both directions and if not 

press the Shift key. Enter a length of 20mm and hit enter.  

4. Click on the Chamfer Equal Setbacks command and click the front edge. 

Set the setback value to 0.5mm and hit Enter. Click the opposite end and 

right mouse click to finish.  

5. From the Application button, click Info and then File Properties. In the Summary tab, enter “Pin” into 

the Title field. In the Project tab, enter 1004 in the Document Number field, 1 in the Revision Number 

field and Marking Gauge into the Project field. Click the OK button.  

6. From the quick access toolbar, click the Save button and call the file “Pin.par” and close the part. 

This completes thiThis completes thiThis completes thiThis completes this exercise and part.s exercise and part.s exercise and part.s exercise and part.    

Exercise 5 – Building the Scriber  

1. From the Application button, select New and then select “ISO Metric Part” to create a new part file.  

2. Select the “Circle by Centre” command  and place the centre of the circle at the centre of the 

coordinate system (see left). Set the diameter to 3mm and hit Enter. Double click the mouse wheel 

to view to full size.  

3.3.3.3. Click the area inside the circle and click on the arrow on the steering 

wheel. Ensure the extended profile is moving in both directions and if not 

press the Shift key. Enter a length of 20mm and hit enter.     

4.4.4.4. Click the Chamfer Unequal Setbacks command. Click the end of the shaft 

and then right mouse click to accept the face selected. Click the edge of 

the face just selected and then enter 1.5mm as the setback and 60 as the Angle. Right mouse click 

to accept the inputs and complete the command.  Click Finish.    

5. From the Application button, click Info and then File Properties. In the Summary tab, enter “Scriber” 

into the Title field. In the Project tab, enter 1005 in the Document Number field, 1 in the Revision 

Number field and Marking Gauge into the Project field. Click the OK button.  

6. From the quick access toolbar, click the Save button and call the file “Scriber.par” and close the 

part. 

This completes thiThis completes thiThis completes thiThis completes this exercise and part.s exercise and part.s exercise and part.s exercise and part.     
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Exercise 6 – Building the Machine Screw  

1. From the Application button, select New and then select “ISO Metric Part” to create a new part file.  

2. Select the “Circle by Centre” command  and place the centre of the circle at the centre of the 

coordinate system. Set the diameter to 5mm and hit Enter. Right mouse click to finish the 

command. Double click the mouse wheel to view to full size.  

3. Click the area inside the circle and click on the arrow on the steering wheel. Ensure the extended 

profile is moving in only one direction and if not press the Shift key. Move the solid toward the back, 

enter a length of 18mm and hit enter. 

4. Click on the Line command. Rotate the view to approximately what is 

shown by clicking and holding down the mouse wheel at a point near 

the front end of the shaft and dragging left and down. Hover over the 

X-Y plane and hit the F3 key to lock to that plane (use the right mouse 

click if there is more than one option). Press the Ctrl+H keys to switch 

to the sketch view. 

 
5. Place the first point of the line at the centre of the coordinate system. Place the second along the 

face of the part and enter a distance of 4mm and click to create the line. Right mouse click to start 

in a new location and place the first point of the line at the centre of the coordinate system and the 

second out from the part at a distance of 2.5mm.  

6. Move the cursor up and press the “A” key to change from drawing a line to an Arc. By positioning 

the cursor such, you will be automatically placing a perpendicular arc. Place the next point at the top 

of the first line drawn (see above right). Right mouse click to finish. Click the F3 icon to unlock the 

plane. 

NotNotNotNote: e: e: e: The circle with the cross in it when placing the arc defines whether you create a 

tangent or perpendicular arc. If you start at the arc start point and move up or down you will 

create a perpendicular line and if you move left or right, it will be a tangent line. 
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7. Press Ctrl+I to switch back to the isometric view. Click inside the area just created (see below left). 

Grab the blue dot on the steering wheel and place it on the line perpendicular to the part (see below 

middle). Click the torus to begin the rotation and click the 360 option on the command bar (see 

below right). 

8. Click the Line command, hover over the Y-Z plane and press the F3 key to lock the plane. Press 

Ctrl+H to switch to the sketch plane. Move the mouse over the centre of the coordinate system (to 

recognise the geometry) and then move to the left making sure you see the dashed line (indicating 

you are in line with that point). Click to place a point somewhere about half way out. Press the “S” 

key to make the line symmetric (see below right) and a length of 1.5mm.   

 
9. Continue the line string by clicking the next point out to the left of the head of the part (see below 

left). Place the next point vertically up and in-line with the top of the first line placed (see below 

middle) and finally close the shape. Click the F3 icon to un-lock the sketch plane. 

10. Press Ctrl+I to switch to the isometric view. 

11. Click inside the region of the rectangle just created and click on the steering 

wheel arrow. Making sure the cutout is moving in both directions (press the 

shift key if is not), click at a point beyond the part.  
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12. Click the Thread command, select the shaft of the part (see below left). On the command bar, the 

thread should display as M5. Change the Extent option to “To cylinder extent”. Press the escape 

key to exit the command.  

13. From the Application button, click Info and then File Properties. In the Summary tab, enter “Machine 

Screw” into the Title field. In the Project tab, enter 1006 in the Document Number field, 1 in the 

Revision Number field and Marking Gauge into the Project field. Click the OK button.  

14. From the quick access toolbar, click the Save button and call the file “Machine Screw.par” and close 

the part. 

 

This completes thiThis completes thiThis completes thiThis completes this exercise and part.s exercise and part.s exercise and part.s exercise and part.    

 

Exercise 7 – Building the Assembly  

1. From the Application button, select New and then select “ISO Metric Assembly” to create a new 

assembly file. 

2. On the left of the screen there are some tabs hidden in the 

side panel, hover over the Parts Library so that it pops out 

into the display (navigate to the folder that you saved your 

parts into if it does not display the right folder). Double click 

on the “Flange.par” part and this will position the part 

matching the coordinate system origin with the coordinate 

system origin of the assembly. 

3. With the Parts Library still displayed, click on the Shaft.par 

and notice that an image of it is displayed in the bottom of 

the parts library. By moving the mouse over this preview 

window you will see the commands for view rotation. Hold 

down the mouse scroll wheel and rotate the part so the 

hole is off to the left. The orientation of the part in the 

preview window is the orientation of the part when it is 

placed in the assembly. Move back up to the text of the part name (Shaft.par), click and drag the 

part into the assembly – it is now ready for you to define the relationships of how this part is 

positioned in relation to the flange. The shaft will be displayed as transparent while positioning it. 
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4. On the command bar, the relationship displayed will be the Flash Fit , which is used adapts to 

the face and orientation first selected and can be used as a mate or aligned relationship. Select the 

outside diameter of the shaft and Flash fit assumes an axial alignment mode. You next need to 

specify the face that it will be aligned with. Select the central hole of the flange (See below right). The 

shaft will now move to satisfy the relationship and this completes the first relationship. Generally, 

there are 3 relationships required to fully position a part. In the list of assembly parts (on the left of 

the screen), called the Pathfinder, the icon for the part will be shown as not fully constrained , by 

having the corner markers on the icon. This relationship is displayed as unlocked, so it will be free to 

rotate. 

 
5. Use the viewing cube in the bottom right of the screen to rotate the assembly around 

by clicking on the top right corner, highlighted in the image as gold. 

6. The second relationship will align the flat at the top of the shaft to be horizontal. As 

there are no flat surfaces on the flange, we will need to use the flange or assembly reference planes. 

We could use the flash fit, but will change to planar align. Select Planar Align from the drop down list 

on the Command bar. Select the flat face on the top of the shaft. On the command bar, change the 

position setting to Float (this is the same as saying it needs to be parallel and if you don’t change 

this, Solid Edge will not allow you to use the reference plane as it can’t satisfy the axial align and the 

fixed alignment). Pick the base X-Y plane of the assembly (right mouse click to use QuickPick to 

select it), see below right.    
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7. Leaving the relationship type on planar align and select the end of the shaft (with the hole in it). On 

the command bar, change the position setting back to Fixed and change the distance to -40mm. 

Select the large face on the flange as the one to align to. This fully constrains the part and is shown 

as such in the Pathfinder .   

8. In the Parts Library, click on the Scriber.par and rotate the part in the viewer pane so the point is 

pointing down. Drag the scriber into the assembly from the pathfinder. Leaving it on FlashFit, pick 

the flat end of the Scriber (see below left). For the aligned face, pick the top, flat edge of the shaft 

(see below right).  

 
9. For the second relationship, pick the shaft (axis) of the scriber. On the command bar, click the Lock 

rotation icon  and then click the top hole (see below right).   

10. Select the Machine Screw from the Parts List and drag it into the assembly. For the first relationship, 

click the threaded shaft of the screw (see below left). On the command bar, click the lock rotation 

and then select the hole in the end of the shaft (see below right). 

11. To make it easier to place the last relationship, un-

check the toggle box alongside the Shaft.par in the 

pathfinder to hide the shaft.   
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12. For the final relationship, select the Tangent relationship from the command bar. Select the flat end 

of the thread shaft (see below left) and then select the cylindrical face of the Scriber (see below 

right).  

13. In the Pathfinder, click on the Shaft check-box to re-display it. Press Ctrl+I to switch back to the 

normal Isometric view. 

14. Drag the Lockscrew from the Parts Library into the assembly. The part will be placed into the 

assembly document at the place you let go of the mouse. Click on the threaded shaft of the 

Lockscrew (see below left), turn on the Lock rotation from the command bar and select the top hole 

in the flange (see below middle). The FlashFit command will move the part to the nearest setting, so 

if the part is positioned upside-down (see below right), click the Flip button on the command bar.     

15. Change the relationship type to Connect (which allows a point/line/plane to connect to a line/plane). 

 
16. Click on the point of the lockscrew (see below left). For the second point, select the top, flat edge of 

the shaft (see below right).  

17. Finally, drag the pin into the assembly and select the diameter of the pin, 

with a locked rotation and then the hole in the lockscrew. 

18. On the Command bar, click the Show Reference Planes option. 

19. On the Command bar, change the relationship type to Planar Align. 

Select the front reference plane of the pin (see below left). Pick the X-Z 

base reference plane of the assembly.  
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20. From the Application button, click Info and then File Properties. In the Summary tab, enter “Marking 

Gauge” into the Title field. In the Project tab, enter A100 in the Document Number field, 1 in the 

Revision Number field and Marking Gauge into the Project field. Click the OK button.  

21. From the quick access toolbar, click the Save button and call the file “Marking Gauge.par” and close 

the part. 

 

This completes thiThis completes thiThis completes thiThis completes this exercise and s exercise and s exercise and s exercise and the assemblythe assemblythe assemblythe assembly....     

Exercise 8 – Exploded Assembly  

1. To help tell one part from another, you can add colours to the 

parts. To do this, you will first need to select a part, so start by 

selecting the shaft. On the View tab, click the drop-down for 

Face Overrides Style and select Black. Select the Flange and 

change it’s colour to Blue and finally change the colour of the pin to Brass. 

2. To make it easier to see each individual parts in the working drawing (see later) when you create a 

Parts List, you will now create an exploded view. On the Tools tab, click on the ERA 

(Explode, Render, Animate) button. 

 
3. Parts can either be manually or automatically exploded. The direction and position of the exploded is 

driven by the relationships placed on the parts. In this case, you will use the Automatic option and 

then manually adjust one part. 

4. Press the Auto Explode option from the ribbon bar. 

On the command bar, click the tick to accept the option 

of Top-level assembly. Click the Explode button on the 

command bar to complete the task. Click Finish and then 

Cancel.    

5. Notice the scriber is displayed below the shaft, whereas it 

would look more consistent to be displayed above the 

shaft. 

6. Click on the Scriber part and notice the spread distance is displayed. Add a minus (-) in front of the 

distance figure and hit enter to see the placement of the scriber move. The flow line is still shown in 

the wrong location, so you will adjust that too. 

7. Click on the Modify (flow Line) button and select the flow line 

displayed above the scriber. Click the Blue dot (handle) that is 
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position over the arrow head (and scriber) of the flow line (see below 

left). Click the hole that the scriber will be fitted into as the destination 

point of the flow line (see below middle).  

8. For the exploded view to be used in the working drawing, it needs to be 

saved as a configuration. Click on the Configurations drop-down list and 

then click the New button. Type “Exploded” in the Name box and click 

OK. Should you want to come back and edit this later, you can re-enter the ERA environment and 

re-select the Exploded setting from the drop-down and then make any changes you require. 

9. Click the Close ERA button in the top right of the screen to return to the normal assembly 

environment. Notice the assembly reverts back to its normal layout. 

10. Save the assembly. 

 

This completes thiThis completes thiThis completes thiThis completes this exercise and s exercise and s exercise and s exercise and the assemblythe assemblythe assemblythe assembly....    

 

Exercise 9 – Setting up the Working Drawing  

1. Despite the fact that 3D printing is becoming more popular, it is still important to create 2D working 

drawings for either assembly instructions or detailed drawings of parts so that sizes can be checked 

when the parts are created.    

2. From the Application button, click New and then Drawing of Active model. This takes the file you are 

in and opens up a 2D drawing sheet and has the assembly ready to place. Accept the default 

template by clicking the OK button. The isometric view of the assembly is displayed on the end of 

the cursor on the drawing sheet (automatically scaled to fit 

the sheet). The first sheet of the draft file is going to display 

the parts list, so you need to change to the exploded view 

that you just created. On the Command Bar, select the 

Drawing View Wizard Options button . In the 

displayed dialog box, select Exploded from the Drawing 

View drop-down list. Click OK to close the dialog box.    

3. You will notice the view is now too big for the sheet, so 

use the mouse scroll wheel to adjust the scale to suit. 

Click to place the view just to the right of centre (as 

shown) to leave room for the parts list.    

4. Notice the colour scheme of the parts are not displayed, 

so click on a part of the exploded view and Shading options on the command 

bar and select “Shaded with Edges”. The view does not update automatically, so 

right mouse click on the view and select Update.    
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Note: Note: Note: Note: When a drawing view has a grey border displayed, this means that the view is out of date and 

needs to be updated (as above). If the view has dark corner markers, this means the models are out 

of date and the assembly file needs updating.  

5. On the home tab, click on the Parts List button. This first step here is to select the 

assembly view that the parts list will be generated against. Select the exploded view. The 

outline of the parts list will be displayed on the cursor for placement. On the command bar, click on 

the Properties button .    

6. In the Properties dialog box, click on the Columns tab. Click on 

the Author column and click the Delete Column button. Repeat for 

the File Name column. From the Properties at the bottom of the 

dialog box, select Title and click the “Add Column” button. Repeat 

for the document Number and the Revision Number. In the 

Columns list, click on Title and click the Move Up button so that it 

is after Item Number.    

7. In the Sorting tab, choose Document Number in the Sort by drop-

down.    

8. In the options Tab, click the “Renumber items/balloons according to sort order”    

9. Click Ok to close the dialog box and place the parts list in the bottom left corner of the sheet.    

10. As the columns may not be the best 

width for the data they hold, click on 

the border of the parts list and handles 

will appear at the top of 

each column so that 

you can re-adjust the sizes of the 

columns. Adjust the width of the revision number and document number.    

11. Notice the balloons have been placed on each of the parts and will contain the Item 

number in the top of the balloon and the quantity in the bottom. Each of the balloons 

are connected via a dashed line which helps to keep a fixed distance for the balloons from the 

assembly model. If you click on the dashed line, you can drag the distance out further or nearer.    

12. The text in the balloons looks to be small on the size of the drawing, so 

press the Select icon from the home tab and then click on the Smart 

Select  from the Command Bar. Select one of the balloons and 

make sure that only Element Type is selected and click OK. All of the 

balloons will now be selected so that you change the properties of all 

of them at the same time. On the command bar, change the Text Scale option to 2.    
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13. After rechecking the parts list, you will notice that the material of the parts is not displayed. Click on 

the parts list and then click on the Properties button on the command bar. Locate and double click 

on Material in the Properties List to add it as a column. Click on the data tab and click on the 

column header for Document Number and then change its position to Centre. Repeat for the 

Revision Number column. Click OK to close the dialog box. Notice that the 

data in the Material column is blank as, if you remember, it wasn’t entered 

when the parts were created. 

14. Save the draft file as “Marking Gauge.dft”. 

15. Click on the Application button and select Property Manage from the Info tab. From here, you are 

able to add or modify any of the properties from the parts and assembly that is connected to the 

draft file (this option is also available in the assembly environment). 

16. The property (material) that you wish to enter may not be displayed as a 

column, so right mouse click on any of the column headers and click 

Columns. Locate Material in the list and click the check box to display 

it. Click OK to close the dialog box. 

17. Click the drop-down alongside the material for the Flange 

and select Material Table from the bottom of the list. The 

Material table allows you to select from a set of different 

standard list and you can also create you own based on 

an existing description. In the list on the left open out the 

Metals option, then Steel and click on the Steel option, as shown here. All of 

the characteristics of the material are shown. Most of the parts in this assembly 

are mild steel, so you will need to add a material. Right click on the Steel in the 

list and click Copy (see below left). Right mouse click on the Header called Steel (see below middle) 

and click Paste. Right click on the new material (Steel (1) ) and select Re  name and label it Mild 

Steel.  

18. Change the values for the Mild Steel as shown. 

Click on one of the other materials and select Save 

when you are prompted.       

19. Click Back on Mild Steel and click OK. 

Set all of the other parts to Mild Steel, apart from 

the scriber, which should be set to Stainless Steel. Click OK to close the Property Manage dialog 

box. The Parts list will now have a grey border around it, so right mouse click on it and click Update. 

The exploded view will also need updating.           

 

This completes thiThis completes thiThis completes thiThis completes this exercise and s exercise and s exercise and s exercise and sheet 1 of the Draft filesheet 1 of the Draft filesheet 1 of the Draft filesheet 1 of the Draft file    
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Exercise 10 – Detailing parts  

1. Right mouse click on Sheet1 at the bottom of the page and select Insert to create a second sheet. 

2. To ensure that you are using the correct projection, click the 

Application button and click Options from the Setting tab. In 

the Drawing Standard section, make sure that projection 

angle is set to Third angle. 

3. On the Home Tab, click on the View Wizard  button. 

As you have already placed the assembly in the draft file, you will see a list of the assembly and all of 

its parts. Click on Flange.Par and click OK. The isometric view is displayed by default as that is the 

view that was placed in the first sheet. 

4. On the Command bar, click the Drawing View Layout  

button. The view Layout box allows you to place multiple 

views in one operation. Choose the front view as the 

Primary view and click the button to the right to place that 

view also. Click Ok to finish. You will now see 2 views to 

place on the sheet. Place the views in the top left corner of the sheet. If the spacing between the 

view is too great, select one of the views and drag it closer. Notice that the views are linked so that 

they remain aligned. Isometric views are not aligned to the principal views. 

5. Now that the views are positioned, click on the Automatic Centrelines  

button on the Home tab in the Annotation section. Select both 

drawing views in turn to apply the centrelines.  

6. Select the Smart Dimension button and change the Text Scale to 2 on 

the command bar. Select the large diameter (shown) and click a point 

directly to the right of the view.  
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7. Select the Distance Between  button. This tool allows you to create stacked or chained 

dimensions and is controlled by the second dimension created. The first line/point selected will be 

the datum for the set of dimensions. Pick the right end of the smaller diameter (see below left). 

When using the dimension tools, try to avoid clicking on the keypoints (show as a blue dot). For the 

next point of the dimension pick the opposite end of the shaft  (see below middle). The dimension 

should now display on the cursor. Position the dimension as shown 

below right. 

8. As the datum for the dimension has been defined, click the far left edge of the part (see below left). If 

you position the dimension in line with the first dimension, the dimensions will be chained. In this 

case, drag the dimension to a position below the first to c reate stacked dimensions (see below 

right).    

9. Select the symmetric Diameter dimension . Select the centreline through the middle of the flange 

as the first point (see below left). Select the outside edge of the shaft (see below left middle). On the 

command bar, make sure the Diameter Half/Full is selected. Place the dimension to the right of 

the view (see below right, middle).  

10. Repeat the process for the counterbore diameter and hole (see above right). 
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11. If you need to add a dimension into a dimension stack, Solid Edge is smart enough to allow you to 

add one in. Click the Distance Between Dimension command. For the first point, click the leader 

(datum) line of the other dimensions (see below left). Click the centre line of the tapped hole (see 

below middle). Place the dimension over the top of the 20mm dimension and you will notice the 

other dimensions are shuffled out to make it fit. 

12. Click on the 25 Diameter Counterbore dimension on the left. On the command bar, click the Prefix 

button and enter “C’bore” in the Prefix text 

box and “x 5 deep” in the Suffix box. Click OK.  

13. Click the Smart Dimension button and select the angled line (see below left). On the command bar, 

select the Angle dimension button  and place the dimension, as shown below.  

 

14. Click the Callout  button on the home tab in the Annotation section. The Callout Text section 

should be blank, if not clear it out. Click the Thread Size button in 

the Feature reference section and the code %TS will appear as the 

Callout Text. Click OK to close the dialog box. Click the threaded hole as shown below. Place the 

callout text as show below, right. 
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15. Click on the Balloon command and on the command bar make sure the 

Leader button  is on, as well as the Link to parts list 

. Click the Property Text button , change the 

drop down to From Graphic Connection and double click 

“Parts list Item number”. Click OK. This values should now appear in the Upper 

box. Click on the part (so that it picks up its connection) and place the balloon similar to as shown 

here.  Press the Esc key to exit the command, select the balloon and turn off the Leader line. 

and delete the existing Callout text. Click on the Property Text  16. Click on the Callout button 

button. Change the drop down to  and double click Title from the list of 

Properties. The code %{Title|G} will be displayed in the property text field. 

Click OK. Click on the part at some point (similar to the balloon) and place 

the text to the right of the balloon. This result should look like the following.  

17. Click on the View Wizard button. Click on Shaft.Par in the list and Click the OK button. On the 

command bar, click the view orientation button and click Front 

and OK. Place the view in the bottom left of the sheet, leaving 

from for the end view to be placed to the left of this view. Move 

to the left and notice that the next view is ready to be placed. 

Place the end view as shown. Right mouse click to exit the command. 

18. Using the Automatic Centreline command , place centrelines on both views. 
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19. Right mouse click on the Front view of the shaft and select “Add break lines”. Add the first point just 

to the right of the end hole and the second just left of the shaft right end. On the command bar, 

change the break type to Cylindrical.  

20. Click the Smart Dimension command and place a dimension on the end view of the flat along the 

top of the shaft (see below left). For the next dimension, select the outside of the shaft in the end 

view. Notice that as it is not a full circle, the dimension defaults to a radial dimension. On the 

command bar, select the Diameter button to switch the dimension type. Place the dimension as 

shown. 

21. Select the Distance between dimension and select the left end of the front view (see below left). 

Select the centreline of the drilled hole and place the dimension (see below middle). Select the right 

end of the shaft and place the dimension as a stacked dimension (see below right). 

22. Right mouse click to reset the datum face, select the right end of the shaft and then select the line 

marking the edge of the chamfer. Hover the mouse over the 15mm dimension at the 

other end of the shaft (for alignment) and place the dimension as shown. Press the Esc key to exit 

the command and select the dimension just placed. Click the Prefix button on the command bar 

and type “x 45” in the Suffix box and click the degree  button from the special characters section. 

Click OK. 

23. Click the Callout button and delete the existing Callout 

text. Click the Thread Size icon , press the space key and 

then click the Smart Thread depth icon . Click OK. Click the 

thread and place the dimension as shown. 

24. While the command is still active, click the Callout properties button on the command bar. Delete 

the existing Callout text. In the Callout text box type “Drill “ and then click the Diameter button and 

the Hole Size button. Click OK to close the dialog box and place the 

callout by selecting a point on the drilled hole and place the callout as 

shown.   
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25. Click on the Balloon command and on the command bar 

make sure the Leader button  is off, as well as turning on Link 

to parts list . Click on the part (so that it picks up its 

connection) and place the balloon similar to as shown here.   

26. Click on the Callout button and delete the existing Callout 

text. Click on the Property Text  button. Change the drop down to  

and double click Title from the list of Properties. The code %{Title|G} will be displayed in the property 

text field. Click OK. Click on the part at some point (similar to the balloon) and place the text to the 

right of the balloon. This result should look like the following.  


